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Having server hardware that is up-to-date, robust, and reliable for growing
workloads is important when planning small- or medium-business (SMB) IT strategy. New
tower servers can offer necessary resources out-of-box, but the ability to apply hardware
upgrades that increase workload performance and capacity can help your business as
demands grow. The new Dell PowerEdge T630 can offer immediate performance benefits to
SMBs running mixed workloads on a legacy server and can provide growing room for
businesses through upgrades to memory and solid-state drives (SSDs).

In our hands-on testing at Principled Technologies, we measured the mixed-
workload performance of the Intel Xeon E5-2660 v3 processor -powered Dell PowerEdge
T630 and first compared it to a legacy HP ProLiant ML350 G6 server. We found that the
PowerEdge T630 server, when we simulated 200 Exchange, SharePoint®, and file server
users and a single, heavy database workload simultaneously, delivered 97.9 percent better
Exchange Server latency, 27.3 percent better SharePoint latency, 131.9 percent more file
server input/output operations per second (IOPS), and 421.9 percent more database
performance than the HP ProLiant ML350 G6 did. We then tested multiple upgrade
configurations of the PowerEdge T630, and increased the applications’ demands to show
performance benefits that come with upgrading these various components. Each
component upgrade supported more workload users and more database instances.

Choosing an Intel processor-powered Dell PowerEdge T630 for your datacenter can

bring necessary resources and upgrade capabilities to handle business growth.
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BETTER PERFORMANCE WITH THE DELL POWEREDGE T630

Businesses running tower servers purchased four or more years ago must work
with aging hardware that can limit resources and constrict user growth. New servers,
such as the Dell PowerEdge T630 tower server, powered by Intel Xeon E5-2660 v3
processors, offer robust hardware to help avoid application performance deterioration
and have designs that promote component upgrades.

We tested the PowerEdge T630 several ways. First, we compared a base
configuration of the server to a four-year-old legacy server. We set up the following
solutions:

e An Intel Xeon processor E5-2660 v3-based Dell PowerEdge T630 as our
base configuration, running Windows Server® 2012 R2 with Hyper-V®

e An HP ProlLiant ML350 G6 as our legacy server, running Windows Server
2008 R2 with Hyper-V

To demonstrate the performance benefits of migrating workloads to the new
Dell tower server, both solutions had virtual instances of Microsoft® SQL Server® 2012,
Microsoft Exchange Server 2010, SharePoint Server 2010, and a file server, each on its
own Windows Server 2008 R2 VM. In this comparison, we simulated the workload of
200 users each for Exchange, SharePoint, and file server and ran a heavy SQL database
workload. Our Exchange and SharePoint VMs each had to support their 200 users with
an acceptable latency (under 100ms for Exchange and under one second for
SharePoint). Our file server VM needed to perform a minimum of 0.3 IOPS per user, or
60 IOPS for 200 users. Each of our database VMs needed to deliver 14,000 orders per
minute (OPM) on average. We measured Exchange performance using Exchange Load
Generator 2010, SharePoint performance using WSSDW 1.0, database performance with
DVD Store 2.1, and file server performance using lometer. For more information on
what and how we tested, see Appendix A.

In our second set of tests, we compared the base configuration of the
PowerEdge T630 against configurations with upgraded hardware components to see
how workload performance increased at every step. Each upgraded configuration saw a
new component in addition to the component from the previous step, introducing a
new way to increase performance in a mixed workload environment. We upgraded with
the following components:

e Memory — upgrade to 384 GB of RAM
e Drive type — upgrade to four 800GB SSDs

For detailed information on the test systems, see Appendix B; for detailed steps

on how we tested, see Appendix C; and for detailed results, see Appendix D.
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WHAT WE FOUND

Mixed workload performance vs. a legacy server
When we ran our mixed workload on the legacy server solution simulating 200

Exchange, SharePoint, and file server users and a heavy database workload, the server had
considerably higher latencies in Exchange and SharePoint, and lower IOPS and orders per
minute (OPM) for the file server and database workloads. Figure 1 shows how the Dell
PowerEdge T630 powered by Intel Xeon E5-2660 v3 processors delivered better
performance across the board in the baseline configuration when compared to the HP
ProLiant ML350 G6.

Percentage win over

Dell PowerEdge T630 HP ProLiant ML350 G6 legacy HP
Exchange latency (ms) 1.67 81.04 97.94
SharePoint latency (sec) 0.16 0.22 27.27
lometer IOPS 123.60 53.29 131.94
DVD Store instance 1 (OPM) 16,014 3,068 421.97

Figure 1: Total performance results for the two systems and win percentages for the PowerEdge T630. For latency,
lower numbers are better, and for the benchmarks, higher numbers are better.

Mixed workload performance with upgrades
Figure 2 shows the increased number of users delivered by upgrading components
supporting Exchange, SharePoint, and file server users while supporting additional SQL
database workloads.
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Increasing memory

First, we upgraded the RAM in the Dell PowerEdge T630. This can benefit a
mixed workload environment by allowing a greater amount of data from each VM to
reside in memory cache, especially online transaction processing (OLTP) workloads. The
baseline configuration of the PowerEdge T630 we tested included 128 GB of RAM. As
Figure 3 shows, increasing this to 384 GB supported the workload of an additional 100
Exchange, SharePoint, and file server users and ran an additional heavy SQL database
workload while delivering the necessary performance. See Appendix D for detailed test

results and benchmark outputs.

Number of Number of Number of Number of
Exchange users SharePoint users file server users SQL Server VMs
Dell Pc.)werEdge T630 200 200 200 1
(baseline)
Dell PowerEdge T630
with 384GB RAM 300 300 300 2

Figure 3: Performance results and increases when upgrading to 384GB RAM.

Upgrading HDDs to SSDs

The next upgrade replaced the SAS hard disk drives (HDDs) on our external
storage array to SSDs. This upgrade removed I/O performance bottlenecks, allowing the
Dell PowerEdge T630 to increase supported workloads and further unlock benefits from
having increased memory.

Upgrading to SSDs increased the number of supported Exchange, SharePoint,
and file server users by an additional 100 users, or 400 users total per application when
compared to the base configuration while maintaining performance. In addition, it
increased the number of supported SQL VMs from two to 12 while delivering the
required 14,000 OPM per VM minimum. Figure 4 shows the effect that upgrading these
components had on capacity and performance. See Appendix D for detailed test results

and benchmark outputs.

Number of Number of Number of file Number of SQL
Exchange users SharePoint users server users Server VMs
Dell Pc?werEdge T630 200 200 200 1
(baseline)
Dell PowerEdge T630
with SSDs 400 400 400 12

Figure 4: Performance results and increases when upgrading drives to SSDs.
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CONCLUSION

Legacy tower servers that cannot meet workload demands can restrict business
growth. By upgrading to the Dell PowerEdge T630, powered by Intel Xeon E5-2660 v3
processors, you can obtain immediate benefits for current IT performance needs and
implement upgrades that will expand server capabilities to help meet future demands.
We found that replacing a legacy server with the new Dell PowerEdge T630 tower server
offered up to 97.9 percent lower workload latency, 131.9 percent more IOPS, and 421.9
percent more OPM when running the same workload. With component upgrades, the
Intel-powered PowerEdge T630 supported more Exchange, SharePoint, and file server
users, and more database VM instances. Help ensure that your applications have
sufficient hardware resources to keep up with the needs of today and the future by
choosing to upgrade to the new Dell PowerEdge T630 tower server.
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APPENDIX A - ABOUT THE COMPONENTS
About the Dell PowerEdge T630

The Dell PowerEdge T630 is a two-socket tower server, a member of the thirteenth generation of PowerEdge
servers, and designed to accelerate demanding workloads. According to Dell, the PowerEdge T630 can provide benefits
in the following ways:

e Performance: The latest Intel Xeon processor E5-2600 v3 product family powers the PowerEdge T630. In

addition, the PowerEdge T630 has DDR4 memory and seven 1/O slots.

e Capacity: The PowerEdge T630 supports up to 32 2.5"” or 18 3.5” hard drives for a maximum capacity of up
to 72 TB. Flexible storage configurations can allow your business to meet exacting workload requirements,
while ample drive space can allow for cost-effective, in-server expansion.

e Storage I/0: Up to four NVMe Express™ Flash PCle® SSDs and the optional 12Gb PowerEdge RAID Controller
(PERC9) make the PowerEdge T630 a strong choice for IOPs-hungry workloads. In-server storage tiering and
multi-mode RAID options can help optimize virtual storage for VMware® vSAN™ and Microsoft Storage
Spaces.

e GPU: From graphical rendering to implementing virtual desktops, support for up to four optional GPU
accelerators enables additional performance and capability.

About the Intel Xeon processor E5-2600 v3 product family
According to Intel, the Intel Xeon processor E5-2600 v3 product family “helps IT address the growing demands

placed on infrastructure, from supporting business growth to enabling new services faster, delivering new applications in
the enterprise, technical computing, communications, storage, and cloud.” It also delivers benefits in performance,
power efficiency, virtualization, and security.

Learn more at www.intel.com/content/www/us/en/processors/xeon/xeon-e5-brief.html

About our test workloads

Database testing
About DVD Store 2.1
To create our real-world ecommerce workload, we used the DVD Store Version 2.1 benchmarking tool. DS2

models an online DVD store, where customers log in, search for movies, and make purchases. DS2 reports these actions
in orders per minute that the system could handle, to show what kind of performance you could expect for your
customers. The DS2 workload also performs other actions, such as adding new customers, to exercise the wide range of
database functions you would need to run your ecommerce environment.

We ran DS2 with 32 threads per VM on both solutions, with a 0.1-second think time. Each SQL Server instance
needed to deliver a minimum of 14,000 OPM.

For more details about the DS2 tool, see www.delltechcenter.com/page/DVD+Store.

Mail testing
To test the solution’s mail server performance, we used the Microsoft Load Generator 2010 (LoadGen)

benchmark, performing tasks to simulate a heavy user generating mail activity. For our workloads, we used the following

settings for the user mailboxes:
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e Mailbox Profile: 250MB mailboxes

e Action Profile: Very heavy

e C(Client Type: Outlook_500

For more details about LoadGen, see www.microsoft.com/downloads/details.aspx?Familyld=DDEC1642-F6E3-
4D66-A82F-8D3062C6FA98&displaylang=en.

Collaboration testing
To simulate the traffic of SharePoint Server 2010 users, we used the WSSDW 1.0.0.0 Beta test. This test creates

sample data, populates the server with it, and simulates SharePoint Server users completing everyday tasks.

We used Visual Studio® 2010 to execute the test workload, generating a realistic user workload where each of
the simulated heavy users performed a task every minute. To do this, we set up the test to run 100, 150, and 200 Visual
Studio virtual users with a 30-second think time between each of the various tasks, to simulate 200, 300, and 400 users
for the solutions throughout the comparison and hardware upgrades. The virtual user count here was set to match the
Exchange user count. The test workload then reports throughput in tests per second.

For more details about SharePoint Server, see office.microsoft.com/en-us/sharepoint-server-help/.

File server testing
To simulate file server performance of the solutions, we used the lometer tool, which measures IOPS and

throughput on both single and clustered systems. lometer performs /O operations to stress a system, and then records
the performance of these I/O operations and the system stress they create. We used lometer 1.1.0 to simulate a file
server workload with varying block sizes and |/O patterns (see Figure 5), with one lometer worker and 100GB dataset on
both solutions. We used one worker and tuned the number of outstanding I/Os to 1, 2, and 3 to simulate 200, 300, and
400 users, respectively, throughout the comparison and hardware upgrades, each generating between 0.3-0.5 IOPS. For

more details about lometer, see www.iometer.org.

Size Reads Random
Block size (percent) (percent) (percent) Delay Burst Align Reply
512 10 80 100 0 1 4,096 0
1,024 80 100 0 1 4,096 0
2,048 80 100 0 1 4,096 0
4,096 60 80 100 0 1 4,096 0
8,192 2 80 100 0 1 4,096 0
16,384 4 80 100 0 1 4,096 0
32,768 4 80 100 0 1 4,096 0
65,536 10 80 100 0 1 4,096 0

Figure 5: Access specification configuration information.
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APPENDIX B — SYSTEM CONFIGURATION INFORMATION

Figure 6 provides detailed configuration information for the test systems. We used the Dell PowerEdge R910 to

host our client machines.

System

Dell PowerEdge R910

Dell PowerEdge T630

HP ProlLiant ML350 G6

Power supplies

Total number

4

2

2

Vendor and model

Dell OTCVRRAOO

Dell 0TPJ2XX03

HP DPS-750RB A

number
Wattage of each (W) 1,100 750 750
General
Number of processor 4 5 5
packages
Number of cores per 3 10 4
processor
Number of hardware
2 2 2
threads per core
System power . Balanced Balanced Balanced
management policy
CPU
Vendor Intel Intel Intel
Name Xeon Xeon Xeon
Model number X7560 E5-2660 V3 E5530
Socket type 1567 LGA 2011-3 LGA 1366 LGA
Core frequency (GHz) | 2.27 2.60 2.40
Bus frequency 6.4 GT/s 9.6 GT/s 5.86 GT/s
L1 cache 8 x32KB 10 x 32 KB 4 x 32 KB
L2 cache 8 x 256 KB 10 x 256 KB 4 x 256 KB
L3 cache 24 MB 25 MB 8 MB
Platform
Vendor and model .
number Dell PowerEdge R910 Dell PowerEdge T630 HP ProLiant ML350 G6
Motherboard model | 0,1 OWIWXC ProLiant ML350 G6
number
Motherboard chipset Intel 7500 Intel ID2F0O0 Intel 5520
BIOS name and Dell 2.10.0 Dell 0.3.23 HP D22 07/02/2013
version
Memory module(s)
Total RAM in system
(GB) 1,024 384 64
Vendor and model Samsung M393B2K70CMO0- | Hynix Semiconductor Samsung M393B1G70DJ1-
number CF8 HMA42GR7MFR4AN-TF CF8
Type PC3-8500 DDR3 ECC PC4-17000 DDR-4 ECC PC3-8500 DDR3 ECC

Speed (MHz)

1,066

2,133

1,066
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System Dell PowerEdge R910 Dell PowerEdge T630 HP ProLiant ML350 G6

Speed running in the 1,066 2133 1,066

system (MHz)

Size (GB) 16 16 8

Number of RAM 64 24 8

module(s)

Rank Quad Dual Quad

Disks

First hard drive

Vendor and model HP Branded

number Seagate® ST9300653SS Seagate STI000NMO0023 2 x Toshiba® MBF2300RC,
6 x Seagate ST9146852SS

Number of disks in 16 18 8

system

Size (GB) 300 1,024 2 x300,6x176

Type 15K SAS 12Gb/s 7.2K SAS 6Gb/s 10k SAS / 15k SAS

Firmware YS08, A04 GSO0D, 1V02 HPD4/HPDE

Second hard drive

Vendor and model N/A SDLFOC7MB800G1H N/A

number

Number of disks in N/A 4 N/A

system

Size (GB) N/A 800 N/A

Type N/A SATA SSD 6Gb/s N/A

Firmware N/A 1DM2 N/A

Disk controller

Vendor and model

Dell PERC H700

Dell PERC H730P

HP Smart Array P410i

Controller cache (MB) | 512 2,048 512
Controller driver 6.600.21.8 6.602.7.0 6.28.0.64
Controller firmware 12.10.2-0004,A08 25.2.1.0026 6.40 (B)

Operating system

Microsoft Windows Server

Microsoft Windows Server

Microsoft Windows Server

Name 2012 R2 Datacenter 2012 R2 Datacenter 2008 R2 Datacenter
Build number 9600 9600 7601
File system NTFS NTFS NTFS
Language English English English
Ethernet
Vendor and model Broadcom® BCM5708C Intel Gigabit Dual Port 1350- .
. HP NC326i
number NetXtreme® Il GigE t Adapter
Type Integrated Integrated Integrated
Driver 7.4.23.2 12.3.35.0 16.4.0.1

Optical drive(s)

Vendor and model
number

TEAC DVD-ROM DV28SV

LDS DVD+-RW DH-16AES

HP DVD-ROM TS-H353C

Type

DVD Reader

DVD Writer

DVD Reader

Hardware upgrades to improve database, SharePoint, Exchange, and
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System Dell PowerEdge R910 Dell PowerEdge T630 HP ProLiant ML350 G6

USB ports
Number 4 8 4
Type 2.0 2.0 2.0

Figure 6: Detailed information on our test systems.
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APPENDIX C—- HOW WE TESTED

Configuring the Active Directory infrastructure server

Installing Microsoft Windows Server 2012 R2 Datacenter Edition

=

Insert the installation media into the CD/DVD drive, and restart the server.
When the option appears, press F11 to enter the Boot Manager.
Select SATA Optical Drive, and press Enter.
Press any key when prompted to boot from DVD.
When the installation screen appears, click My language is English.
Leave language, time/currency format and input method as default, and click Next.
Click Install now.
When the Windows® Setup window appears, click No thanks when prompted to go online to install updates.
Select Windows Server 2012 R2 Datacenter (Server with a GUI), and click Next.
. Check | accept the license terms, and click Next.

LN R WN

=
= O

. Click Custom: Install Windows only (advanced).
. Press Alt+A to open advanced partition options. Delete any partitions until there is only Drive 0 Unallocated

[
N

Space.
13. Select Drive 0 Unallocated Space, and click Next, at which point Windows will begin installing, and will restart
automatically after completing.
14. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.
15. Log in with the previously set up password.
Configuring Windows Update

1. Inthe left pane of the Server Manager window, click Local Server.

In the main frame, next to Windows Update, click Not configured.

In the Windows Update window, in the main pane, click Let me choose my settings.

Under Important updates, select Never check for updates (not recommended), and then click OK.
In the left pane, click Check for updates, and install all available updates.

vk wN

6. Close the Windows Update window.
Configuring Windows Firewall

1. InServer Manager, click Tools=>Windows Firewall with Advanced Security.
In the Overview section, click Windows Firewall Properties.

In the Domain Profile tab, for Firewall state, click Off.

In the Private Profile tab, for Firewall state, click Off.

In the Public Profile tab, for Firewall state, click Off.

Click OK.

7. Close the Windows Firewall Properties window.

o vk wnN

Setting up Remote Desktop

1. Inthe Local Server tab of the Server Manager window, next to Remote Desktop, click Disabled.
2. Inthe System Properties window that appears, in the Remote Desktop section, select the Allow remote
connections to this computer radio button, and click OK when the warning message appears.

Hardware upgrades to improve database, SharePoint, Exchange, and A Principled Technologies test report 11
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3.

Uncheck Allow connections only from computers running Remote Desktop with Network Level Authentication
(recommended), and click OK.

Disabling IE Enhanced Security Configuration

1.
2.

In the Local Server tab of the Server Manager window, next to IE Enhanced Security Configuration, click On.
In the Internet Explorer Enhanced Security Configuration window, select the Off radio buttons for both
Administrators and Users, and click OK.

Installing the Active Directory Domain Services role

Before completing this step, you will need to apply an appropriate IP address for the server. In our case, we used

192.168.1.1.

1.

vk wN

o N

11.
12.
13.
14.
15.
16.

Launch Server Manager, and select Add roles and features.

Click Next at the Add Roles and Features Wizard.

Select Role-based or feature-based installation, and click Next.

Select the AD server from the server pool, and click Next.

Select Active Directory Domain Services from the list of Roles, click the Add Features button to add features that
are required by Active Directory Domain Services, and click Next.

Accept the defaults selected by setup at the Select Features screen, and click Next.

Click Next at the AD DS screen.

Select Restart the destination server automatically if required at the confirmation screen, and click Install.

Click Promote this server to a domain controller.

. Select Add a new forest, type in the Root domain name (fqdn), and click Next. For our testing, we used

test.local

Type in and confirm the password, and click Next.

Click Next at the DNS Options screen.

Verify the NetBIOS name, and click Next.

Accept the default paths, and click Next.

Review the options, and click Next.

Verify the prerequisite check passes successfully, and click Install.

Configuring the HP ProLiant ML350 G6 server
Installing Microsoft Windows Server 2008 R2

These steps outline how we installed Microsoft Windows Server 2008 R2 onto the HP ProLiant ML350 G6 server.

1. Attach the installation media to the host or VM.

2. Power on the host or VM, and boot into the Windows installer.

3. Atthe Language Selection Screen, click Next.

4. Click Install Now.

5. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

6. Click the | accept the license terms checkbox, and click Next.

7. Click Custom.

8. Click Next.

9. Atthe User’s password must be changed before logging on warning screen, click OK.

10. Enter the desired password for the administrator in both fields, and click the arrow to continue.

11. At the Your password has been changed screen, click OK.

12. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
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13. Enable remote desktop access.
14. Change the hostname and reboot when prompted.

Building the virtual machines

1.
2.

4.
5.

Use Server Manager to add the Hyper-V role to the host.

Use Hyper-V Manager to create the appropriate number of virtual machines. We assigned 2 vCPUs and 8 GB of
memory to the SharePoint and file server VMs, and 4 vCPUs and 16GB of memory to the Exchange and SQL
Server VMs. Give the OS VHD 40 GB, and place it on the OS HDDs.

Create the appropriate volumes for each VM as indicated below:

Exchange Server 2010
- Exchange Data —90GB

- Exchange Log— 10GB

SQL Server 2012
- SQL Data - 50GB

- SQL Log—30GB

SQL Server 2012 instance for SharePoint Server 2010
- SharePoint Data — 100GB

File Server
- lometer Data — 110GB

Create a virtual switch connected to the client network, and attach it to the VM.
Attach the OS installation media to the VM, and install the guest OS.

Configuring the Dell PowerEdge T630 server

Installing Microsoft Windows Server 2012 R2 on the Dell PowerEdge T630

These steps outline how we installed Microsoft Windows Server 2012 R2 onto the Dell PowerEdge T630. Attach

the installation media to the host or VM.

1.
2.

O N o v kW

Power on the host or VM, and boot into the Windows installer.

Once the installation files have been copied into memory, select the appropriate language, time and currency
format, and keyboard layout, and click Next.

Click Install Now.

Enter the product key, and click Next.

Choose Windows Server 2012 R2 Datacenter (Server with a GUI), and click Next.

Check the | accept the license terms box, and click Next.

Choose Custom: Install Windows only (advanced).

Select the OS hard drive from the list, and click Next. This begins the installation.

Run Windows Update on each server until the operating systems are completely up to date.

Building the virtual machines

1.

Use Server Manager to add the Hyper-V role to the host.

Hardware upgrades to improve database, SharePoint, Exchange, and A Principled Technologies test report 13
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2. Use Hyper-V Manager to create the appropriate number of virtual machines. We assigned 2 vCPUs and 16 GB of
memory to the SharePoint and file server VMs, and 4 vCPUs and 24GB of memory to the Exchange and SQL
Server VMs. Give the OS VHD 40 GB, and place it on the OS HDDs.

3. Create the appropriate volumes for each VM as indicated below

Exchange Server 2010
- Exchange Data — 150GB

- Exchange Log— 10GB

SQL Server 2012
- SQL Data—50GB

- SQL Log—30GB

SQL Server 2012 instance for SharePoint Server 2010
- SharePoint Data — 200GB

File Server
- lometer Data —110GB

4. Create a virtual switch connected to the client network, and attach it to the VM.
5. Attach the OS installation media to the VM, and install the guest OS.

We then configured each solution to run applications in VMs (SQL Server, Exchange Server, file server, and
SharePoint Server). For our benchmark test clients and domain controller, we configured virtual machines on a separate
Dell PowerEdge R910 server, ensuring that each virtual machine had ample hardware resources. For each solution, we
had a single domain controller VM, and up to five DVD store client VMs, a WSSDW client VM, a file server client, and five

LoadGen client VMs distributing the user workload evenly.

Installing the operating system on the application VMs

1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.
2. Atthe Language Selection Screen, click Next.
3. Click Install Now.
4. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Click the | accept the license terms checkbox, and click Next.
6. Click Custom.
7. Click Next.
8. At the User’s password must be changed before logging on warning screen, click OK.
9. Enter the desired password for the administrator in both fields, and click the arrow to continue.
10. At the Your password has been changed screen, click OK.
11. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
12. Enable remote desktop access.
13. Change the hostname and reboot when prompted.
14. Set up networking:
a. Click Start->Control Panel, right-click Network Connections, and choose Open.
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b. Right-click the NIC assigned to the private network, and choose Properties.
Select TCP/IP (v4), and choose Properties.
d. Setthe IP address, subnet, gateway, and DNS server for the virtual NIC, which will handle outgoing server
traffic. Click OK, and click Close.
15. After creating and configuring the storage volumes on the storage level and in iSCSI initiator:

a. Click the Server Manager icon in the taskbar.

o

In the left pane, expand Storage, and click Disk Management.

Right-click the first volume, and choose Initialize Disk.

In the right pane, right-click the volume and choose New Simple Volume...

At the Welcome screen, click Next.

At the Specify Volume Size screen, leave the default selection, and click Next.

At the Assign Drive Letter or Path screen, choose a drive letter, and click Next.

> @ ™0 a0

At the Format Partition screen, leave the defaults and click Next.
i. Atthe Completing the New Simple Volume Wizard screen, click Finish.
j.  Repeat steps c through i for the remaining volumes.

Configuring the first application VM for SQL Server 2012

Installing Microsoft SQL Server 2012
1. Insert the installation DVD.

2. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2012 DVD, and
double-click.

3. If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core
role.

In the left pane, click Installation.

Click New SQL Server stand-alone installation or add features to an existing installation.

At the Setup Support Rules screen, wait for the rule check to complete. If there are no failures or relevant
warnings, click OK.

Select the Specify a free edition and select Evaluation from the drop-down menu. Click Next.

Click the checkbox to accept the license terms, and click Next.

If no failures are displayed after the setup support files are installed, click Next.

10. At the Setup Role screen, choose SQL Server Feature Installation.

11. At the Feature Selection screen, select Database Engine Services, Full-Text and Semantic Extractions for
Search, Client Tools Connectivity, Client Tools Backwards Compatibility, Management Tools — Basic, and
Management Tools — Complete. Click Next.

12. At the Installation Rules screen, click Next once the check completes.

13. At the Instance configuration screen, leave the default selection of default instance, and click Next.

14. At the Disk Space Requirements screen, click Next.

15. At the Server Configuration screen, check that NT Service\SQLSERVERAGENT is selected for SQL Server
Agent, and that NT Service\MSSQLSERVER is selected for SQL Server Database Engine. Click Next.
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16.
17.
18.
19.
20.
21.
22.

23.
24,
25.

Assuming no failures are displayed, click Next.

At the Database Engine Configuration screen, select Mixed Mode.

Enter and confirm a password for the system administrator account.

Click Add Current user. This may take several seconds.

Click Next.

At the Error and usage reporting screen, click Next.

At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Close.

Close the installation window.

Configuring the second application VM for Exchange Server 2010
Installing .NET Framework 3.5.1 Features and Internet Information Services

1.
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9.

10.

Select Start>Administrative Tools=>Server Manager.

Click Features.

Click Add Features.

Select .NET Framework 3.5.1 Features

Click Add Required Role Services.

Click Next.

Click Next.

At the Select Role Services screen, select the 1IS 6 Metabase Compatibility, IIS 6 Management Console, Basic
Authentication, Windows Authentication, Digest Authentication, Static content compression, and Dynamic
content Compression checkboxes, and click Next.

At the Confirm Installation Selections screen, click Install.

At the Installation Results screen, click Close.

Installing Microsoft Filter Pack 2.0

1.

e W N

Download the Microsoft Filter Pack 2.0.
(www.microsoft.com/downloads/en/details.aspx?FamilylD=5cd4dcd7-d3e6-4970-875e-aba93459fbee)
Run FilterPackx64.EXE.

Click Next.

Click | accept the terms in the License Agreement, and click Next.

When the installation is complete, click OK.

Installing Exchange Server 2010

1. Click Start, type services and press Enter.
2. Right-click the Net.Tcp Port Sharing service, and click Properties.
3. Change the Net.Tcp Port Sharing startup type to Automatic, and click OK.
4. Open command prompt and type ServerManagerCmd —-i RSAT-ADDS, and press Enter.
5. Reboot the server.
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Insert the installation DVD and click Setup.EXE when prompted.

6
7. The installer should consider steps 1 and 2 complete, and gray them out.
8. Click the link for Step 3: Choose Exchange Language Option.
9. Click Install only languages from the DVD.
10. Click the link for Step 4: Install Microsoft Exchange Server 2010 SP1.
11. Click Next to go past the introduction screen.
12. Accept the license agreement, and click Next.
13. Select No for error reporting, and click Next.
14. Select Typical Exchange Server Installation, and click Next.
15. Leave the organization name at default (First Organization), and click Next.
16. At the question about client computers running Outlook 2003 and earlier, select Yes, and click Next.
17. Click Next to accept defaults for Configure Client Access server external domain.
18. At the Customer Experience Improvement Program screen, select | don’t want to join the program at this time,
and click Next.
19. If a warning about a lack of SMTP appears after the check finishes, ignore it.
20. Click Install to start the installation process.
21. Once installation is complete, click Finish.
22. Click OK when prompted to reboot.
23. Click Close.
24. Click Yes to confirm exit.
25. Reboot the server.
Installing SP2 for Microsoft Exchange 2010
1. Download Service Pack 2 for Microsoft Exchange 2010 (Exchange2010-SP2-x64.exe) from
www.microsoft.com/download/en/details.aspx?id=28190 to C:\SP2.
Double-click the downloaded file to extract the installation files.
Click OK to accept the destination directory for the extracted files.
Double-click setup.exe to launch the installer.
Click Install Microsoft Exchange Server upgrade.
At the Introduction screen, click Next.
Accept the terms in the license agreement, and click Next. The Readiness Checks will now run.
Install any roles in Server Manager that the Readiness Checks prompt you to install.

. When the checks successfully complete, click Upgrade.
10. Click Finish, and reboot.

Server 2010 roles
1. Select Start=>All Programs—> Microsoft Exchange Server 2010 Exchange Management Console.
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2. Inthe left pane, click Microsoft Exchange On-Premises.
3. Inthe left pane, expand Organization Configuration, and select Hub Transport.
4. Inthe action pane on the far right, select New Send Connector.
5. Name the send connector SMTP, select the intended use as Internet, and click Next.
6. Inthe Address space screen, click Add.
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10.
11.

In the SMTP Address Space screen, type * as the address, ensure that the installer has checked Include all
subdomains, and click OK.

Click Next.

Accept defaults for the next two pages by clicking Next.

At the New Connector page, click New to create the connector.

Click Finish to close the New SMTP Send Connector wizard.

Configuring the Exchange Server 2010 Mailbox role

Before completing this section, create an additional three mailbox databases so that you have four total, and

complete these steps on each mailbox database.

1. Select Start=>All Programs—> Microsoft Exchange Server 2010 Exchange Management Console.

2. Inthe left pane, expand Organization Configuration, and click Mailbox.

3. Click the Database Management tab.

4. Right-click Mailbox Database, and select Properties.

5. Select the Maintenance tab.

6. Check the Enable circular logging box.

7. Check the box beside This database can be overwritten by a restore.

8. Next to Maintenance interval, click Customize.

9. Remove all blue from the boxes so the system will not perform maintenance, and click OK.

10. Click OK.

11. Click OK to any warnings about circular logging being applied after the database is remounted.

12. On the far right panel, click Move Databases.

13. Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Maillogs respectively,
and click Move.

14. If the application prompts you to dismount, click Yes.

15. Click Finish.

16. Right-click Public Folder Database, and select Properties.

17. Check the Enable circular logging checkbox and uncheck the ESE scanning checkbox.

18. Click Customize next to Maintenance interval.

19. Remove all blue from the boxes so the system will not perform maintenance, and click OK.

20. Click OK.

21. On any warnings about circular logging being applied after the database is remounted, click OK.

22. Click Move Database on the far right panel.

23. Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Publiclogs respectively,
and click Move.

24. If the application prompts you to dismount, click Yes.

25. Click Finish.
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Configuring the third application VM for SharePoint Server 2010

We installed a separate instance of SQL Server 2012 for our SharePoint databases. This prevented creating an

unnecessary bottleneck by having WSSDW and DVD Store running against the same instance of SQL on the same

application server.

Installing Microsoft SQL Server 2012

1.
2.

A

10.
11.

12.
13.
14.
15.

16.
17.
18.
19.
20.

21.
22.
23.

24.
25.
26.

Insert the installation DVD.

Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2012 DVD, and
double-click.

If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
In the left pane, click Installation.

Click New SQL Server stand-alone installation or add features to an existing installation.

At the Setup Support Rules screen, wait for the rule check to complete. If there are no failures or relevant
warnings, click OK.

Select the Specify a free edition and select Evaluation from the drop-down menu. Click Next.

Click the checkbox to accept the license terms, and click Next.

If no failures are displayed after the setup support files are installed, click Next.

At the Setup Role screen, choose SQL Server Feature Installation.

At the Feature Selection screen, select Database Engine Services, Full-Text and Semantic Extractions for Search,
Client Tools Connectivity, Client Tools Backwards Compatibility, Management Tools — Basic, and Management
Tools — Complete. Click Next.

At the Installation Rules screen, click Next after the check completes.

At the Instance configuration screen, leave the default selection of default instance, and click Next.

At the Disk Space Requirements screen, click Next.

At the Server Configuration screen, check that NT Service\SQLSERVERAGENT is selected for SQL Server Agent,
and that NT Service\MSSQLSERVER is selected for SQL Server Database Engine. Click Next.

Assuming there are no failures, click Next.

At the Database Engine Configuration screen, select Mixed Mode.

Enter and confirm a password for the system administrator account.

Click Add Current user. This may take several seconds.

Click the Data Directories tab and enter the appropriate drive and folder to which you will eventually deploy the
SharePoint databases.

Click Next.

At the Error and usage reporting screen, click Next.

At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Close.

Close the installation window.
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Installing Microsoft SharePoint Server 2010
1. Insert the installation DVD.

Launch setup.exe, and click Install software prerequisites.

Review the list of software, and click Next.

Accept the EULA, and click Next.

When the prerequisites finish installing, click Finish.

On the main SharePoint installation menu, click Install SharePoint Server.
Enter your product license key, and click Continue.

Accept the EULA, and click Continue.

Choose the Complete server type, and click Install.
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. When the installation finishes, check the box for Run the SharePoint Products Configuration Wizard now, and
click Close.

11. On the Welcome to SharePoint Products screen, click Next.

12. On the pop-up warning about services that will need to be restarted during the configuration, click Yes.

13. Choose Create a new server farm, and click Next.

14. Enter the name of your existing database instance on the same application server.

15. Specify a username and password, and click Next.

16. Enter a passphrase into the Passphrase and Confirm Passphrase fields, and click Next.

17. Leave the default settings on the Configure SharePoint Central Administration Web Application screen, and click

Next.

18. Verify your settings, and click Next.

19. When the wizard has completed the configuration, click Finish.

20. Choose Run the farm configuration wizard on the Central Administration site.

21. Choose the services you wish to include in your server farm, and click Next.

22. Enter the specifications for the new site, and click OK.

23. Click Finish.

Configuring the database (DVD Store)
Data generation overview

We generated the data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the
parameters for our 40GB database size and the database platform on which we ran: Microsoft SQL Server. We ran the
Install.pl script on a utility system running Linux. The database schema was also generated by the Install.pl script.

After processing the data generation, we transferred the data files and schema creation files to a Windows-
based system running SQL Server 2008 R2 SP1. We built the 40GB database in SQL Server 2008 R2, and then performed
a full backup, storing the backup file on the C: drive for quick access. We used that backup file to restore to the servers
between test runs. We performed this procedure once.

The only modification we made to the schema creation scripts were the specified file sizes for our database. We

explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the
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test. Besides this file size modification, the database schema was created and loaded according to the DVD Store

documentation. Specifically, we followed the steps below:

1. We generated the data and created the database and file structure using database creation scripts in the DS2
download. We made size modifications specific to our 40GB database and the appropriate changes to drive

letters.
a.

We transferred the files from our Linux data generation system to a Windows system running SQL
Server.

We created database tables, stored procedures, and objects using the provided DVD Store scripts.

We set the database recovery model to bulk-logged to prevent excess logging.

We loaded the data we generated into the database. For data loading, we used the import wizard in SQL
Server Management Studio. Where necessary, we retained options from the original scripts, such as
Enable Identity Insert.

We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.
We updated statistics on each table according to database-creation scripts, which sample 18 percent of
the table data.

On the SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL
(TSQL) script:

USE [master]
GO
CREATE LOGIN [ds2user] WITH PASSWORD=N'"',
DEFAULT DATABASE= [master],
DEFAULT LANGUAGE=[us english],
CHECK EXPIRATION=OFF,
CHECK POLICY=0OFF
GO
We set the database recovery model back to full.
We created the necessary full text index using SQL Server Management Studio.
We created a database user and mapped this user to the SQL Server login.

We then performed a full backup of the database. This backup allowed us to restore the databases to a
pristine state relatively quickly between tests.

Running the DVD Store tests
We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store

outputs an orders-per-minute metric, which is a running average calculated through the test. In this report, we report

the last OPM result reported by each client/target pair.

Each complete test cycle consisted of the general steps listed below. For each scenario, we ran three test cycles,

and reported the median outcome.

1. Clean up prior outputs from the server and all client driver systems.
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Drop all databases from the test servers.
Restore all databases on all test servers.
Reboot the server and all client systems.
Let the test server idle until the power utilization settled.
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Start the DVD Store driver on all respective clients.

We used the following DVD Store parameters for testing the servers in this study:
ds2sqglserverdriver.exe --target=<target IP> --ramp rate=10 -
warmup time=15 --run time=45 --n threads=32 --db size=40GB --
think time=0.1

Installing and configuring the Exchange 2010 mail test clients (LoadGen)

For our testing, we used 5 virtual client machines to distribute the LoadGen workload evenly for each of the
solutions. To create the mail clients, we installed several software components. First, we made sure to statically assign
an IP address for each client. We followed this process for each installation:

Installing Windows Server 2008 R2 SP1 Enterprise Edition
1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.
At the Language Selection Screen, click Next.
Click Install Now.
Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
Click the | accept the license terms checkbox, and click Next.
Click Custom.
Click Next.
At the User’s password must be changed before logging on warning screen, click OK.
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Enter the desired password for the administrator in both fields, and click the arrow to continue.

=
o

. At the Your password has been changed screen, click OK.
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. Click Start, type change power-saving settings and press Enter.
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N

. Click Change plan settings.
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w

. Change the Turn off the display drop-down menu to Never.
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S

. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization screens.

To set up this server, we had to install several additional software components. The following subsections detail
the necessary installation processes.
Joining the domain
1. Select Start->Control Panel-> Network Connections—>Local Area Connection.
2. Click Properties.
3. Highlight Internet Protocol (TCP/IP), and click Properties.
4. Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the
Preferred DNS server field. Click OK.
5. Right-click My Computer, and select Properties.
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Under the Computer Name tab, click Change.
In the Computer Name Changes screen, under the Member of section, select the Domain radial box, and type
test.local
Select OK to start joining the domain.
When the screen appears asking for a person qualified on the domain, type Tester as the username and
Passwordl as the password.

10. At the Welcome pop-up window and the window warning that you must reset the computer for the changes to
take effect, click OK.

11. At the System Properties screen, click OK.

12. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services
1. Click Start->Administrative Tools—> Server Manager.

1. On the left pane, click Roles.

2. Click Add Roles.

3. Click the Application Server checkbox.

4. When the Add features required for Application Server? screen appears, click Add Required Features.

5. Click Next.

6. Click Next.

7. Atthe Select Role Services page for Application Server, click the Web Server (IIS) Support checkbox.

8. Click Add Required Support Role Services.

9. Click Next.

10. Click Next.

11. At the Select Role Services page for Web Server (lIS), click IS 6 Management Compatibility, ASP, and CGI
checkboxes; and click Next.

12. Click Install.

13. Click Close.

Installing Load Generator
1. Download Microsoft Exchange Load Generator 2010.

Place the installer on the VM’s local drive.

Before installing, navigate to C:\Windows\System32\drivers\etc.

2

3

4. Open the file “hosts” using Notepad.

5. Atthe end of the file,add 127.0.0.1, press tab, and add crl .microsoft.com
6. Install Load Generator using all defaults.

7

Do this on all VMs needed to run the Microsoft Load Generator 2010.
Preparing Load Generator
1. Ensure the services Microsoft Exchange Load Generator Monitoring Agent and Microsoft Exchange Load
Generator Remote Agent are running on all LoadGen clients. They can be found under the names LoadGenMon
and LoadGenRemote in Windows task manager.
Log in to the mail client using the appropriate account.
3. Select Start->All Programs—> Microsoft Exchange—>Exchange Load Generator 2010.

When the Load Generator screen appears, select Start a new test.
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10.
11.
12.
13.

14.
15.
16.

17.
18.
19.
20.

21.

Select Create a new test configuration, and click Continue.

Change the total length of simulation to 1 hour and 15 minutes.

In the Specify test settings screen, type Passwordl as the Directory Access Password and Mailbox Account
Master Password, and click Continue with recipient management.

Make the appropriate number of users in the Mailbox Database, and click Continue.

To accept defaults for Advanced recipient settings, click Continue.

In the Specify test user groups screen, select the plus sign to add a user group.

Change the Client Type to Outlook_500, the Action Profile to Average, and the Mailbox size to 250 MB.
Check the PreTestLogon checkbox, and click Continue.

In Remote configurations, enter the computer names of all of the test clients, check the checkbox to enable
distributing the workload, and click Continue.

Click Save the configuration file as, and name it testcfg.xml

Open the configuration file in notepad.

Search for FlowControlPoint. In that section, change <Enabled>true</Enabled> to
<Enabled>false</Enabled>

Search for MaximumThreadPoolThreads and change that from 80 to 16

Save and close the config file.

Close and restart LoadGen.

Open the saved (modified) configuration file in LoadGen and navigate through the screens until the summary
screen.

Check the Initialize public store as well checkbox, and click Start the initialization phase (recommended before
running the test).

Backing up the mail databases

On the Exchange server virtual machine, once we set up the LoadGen client and created its initial mail database,

we backed up the databases so we could have clean copies for each test.

1. Select Start=>All Programs—> Microsoft Exchange Server 2010 Exchange Management Console in the mail
server.

2. Inthe left pane, expand Organization Configuration and Mailbox.

3. Inthe right pane, right-click each of the four Mailbox Databases, and select Dismount Database from the menu.

4. Atthe Do you want to continue? pop-up message, click Yes.

5. Right-click Public Folder Database, and select Dismount Database from the menu.

6. Atthe Do you want to continue? pop-up message, click Yes. The red arrow appears when you have dismounted
the Public Folder Store.
Using Windows Explorer, create a new folder: E: \backup\
With Windows Explorer, copy all database and public folder files from E:\Database to E:\backup. This process
may take several minutes.

9. Close Windows Explorer.
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10. In the Exchange Management Console, right-click each of the four Mailbox Databases, and select Mount
Database from the menu.

11. Right-click the Public Folder Database, and select Mount Database from the menu.

12. Close the Exchange Management Console.

Preparing the SharePoint test client
Install Windows Server 2008 R2 SP1 with current updates.

Installing Microsoft Visual Studio 2010 Ultimate Edition
1. Download vs_ultimateweb.exe .
Double-click vs_ultimateweb.exe to run the installer.

Uncheck the box beside Yes, send information about my computer, and click Next.
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If you see a pop-up requiring a Windows Imaging component, click the Windows Imaging Component is
Required link.

5. Click Download on the appropriate Imaging component, and choose Run.

6. Accept the EULA, and click Next.

7. Close the pop-up window.

8. Click Next.

9. Accept the EULA, review the components to be installed, and click Next.

10. Choose the Full installation and location for the install, and click Install.

11. Click Finish.

12. Reboot the machine.

13. Click Start—>All Programs—>Microsoft Visual Studio 2010-> Microsoft Visual Studio 2010.
14. When prompted, select General Development Settings and click Start Visual Studio.

Setting up and running WSSDW 1.0.0.0 Beta

1. Complete the following steps on the Domain Controller machine:

a. Click Start>Administrative Tools—=> Active Directory Users and Computers.

b. Right-click the domain name and select New—>Group.

c. Enter testdomaingroupl for the group name.

d. Repeat steps a through c and create another group named testdomaingroup?2
2. Download the following from sptdatapop.codeplex.com/releases/view/1141

e To the SharePoint 2010 VM
o WSS Data Population Tool RunTime.zip

o WSS Data Population Tool.chm
o WSS Data Population Tool Sample.zip
e To the SharePoint 2010 test client
o WSS Performance Load Tests
3. Complete the following steps on the SharePoint 2010 VM:
a. Extract the contents of WSS Data Population Tool RunTime.zip and WSS Data Population Tool Sample.zip.
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b. Copy the contents of both extracted .zip folders (WSS Data Population Tool Run Time and WSS Data
Population Tool Sample) into the root of C:
4. Download SharePtServerDeployment.doc from www.microsoft.com/en-us/download/details.aspx?id=10009 and

place it into the C:\wssdw folder.

a. Rename WSS Data Population Sample File.xmlto WSS Data Population Sample File.xml so that
there are no spaces in the name. This allows the script to execute from the command prompt.

b. Right-click WSS_Data_Population_Sample_File.xml and click Edit to open the document in Notepad. Scroll
down to line 55 and remove “.txt” from the document name in the destfile parameter. Then, change any
applicable parameters to match the following:

<setproperty NumberOfSiteCollections="100" />

<setproperty SiteNameBase="testsite" />

<setproperty NumberOfGroups="2" />

<setproperty GroupNameBase="testgroup" />

<setproperty TargetDomain="test.local" />

<setproperty DomainGroupRoot="testdomaingroup" />

<setproperty DomainUserName="administrator" />

<setproperty DomainUserPassword="Passwordl" />

<setproperty DesignerGroup="design" AdminGroup="£full control" />

<setproperty NumberOfDocumentLibraries="5" />

<setproperty DocumentLibraryNameBasel="testdoclib A" />

<setproperty NumberOfDocuments="5" />

<setproperty SourceFileLocation="c:\wssdw\SharePtServerDeployment.doc"
/>

<setproperty DestFile="test.doc" />

<setproperty NumberOfFileVersions="3" />

<setproperty DocumentLibraryNameBase2="testdoclib B" />

<setproperty NumberOfLists="10" />

<setproperty ListNameBase="testlist" />

<setproperty NumberOfListItems="20" />

<setproperty webpartpath="webpartpagesfolder" />

c. Open the command prompt and execute the script:
C:\>WSSDW.exe WSS Data Population Sample File.xml

5. Complete the following steps on the SharePoint 2010 test client:
a. Extract the contents of WSS Performance Load Test to C: drive on the SharePoint test client.
b. On the SharePoint test client, open the WSSTransactions folder, right-click=> Edit, and modify the following

files as follows:
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® users.csv
Under username, password enter test.localladministrator,Passwordl and
remove the remaining entries.
e serverUrl.csv
Under serverUrl replace http://server with http://sharepoint to match the
server name of the SharePoint 2010 VM.
e HierarchyManagerUsers.csv
Under username,password replace domain\username, password with
test.localladministrator, Passwordl
Open the WssTestProject.sIn file in Visual Studio 2010 Ultimate.
When prompted, click Next.
Click Finish.
When prompted, leave the Retarget the project to .NET Framework 4. After the project opens, you can

- o o o

retarget it to another Framework or Profile radio button selected, and click OK.
g. Click Close.
h. Inthe Solution Explorer pane, scroll to WSSDispForm, and double-click it.
i. Expand the top menu under WSSDispForm in the left pane, expand Validation rules, and delete the FindText
entry that references mysite.aspx.
j. Click Save.
k. Repeat steps h through j for WSSHomePage and WSSSmallDocLibAllltems.
I.  Click Project>Add Load Test.
m. At the Welcome to the Create New Load Test Wizard, click Next.
n. Enter Test for the load test scenario name, change the think time between test iterations to 45 seconds,
and click Next.
0. Atthe Load pattern settings for a load test scenario screen, select Constant load, enter 125 for the User
Count, and click Next.
Click Next at the Select a test mix model for the load test.
At the Add test to a load test scenario and edit the test mix, click Add and select the following tests from the
list below. Additionally, modify the distribution as follows:
e WSSDispForm 10%
e WSSDocHTTPFetch 30%
o WSSHomePage 20%WSSSmallDocLibAllltems 30%
e WSSPutDocumentCoded 10%
r. Click OK.
s. At the Network types screen, select LAN, and click Next.
t. At the Browser screen, click Next.

u. At the Specify computers to monitor with counters sets during load test run screen, click Next.
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v. Atthe Review and edit run settings for load test screen, enter 15 minutes for the Warm-up duration, enter
30 minutes for Run duration, 15 minutes for the Cool down duration, and click Finish.
To ensure that the WSSDW workload evenly selects different SharePoint sites at random, create .csv lists of a
number of categories within each test and add the following parameters to each:
e WSSD WSSDispForm: Site name, list name, and list IDs.
e  WSSDocHTTPFetch: Site name, doc revision, document library name, and document name.
o \WSSHomePage: Site name
e WSSSmallDocLibAllltems: Site name, and document library name
e WSSPutDocumentCoded: Site name
Add the following lines of code to the WSSPutDocumentCoded test:

[DeploymentItem ("officeservertransactions\\siteNames.csv",

"officeservertransactions") ]

[DataSource ("Sites", "Microsoft.VisualStudio.TestTools.DataSource.CSV",
"|DataDirectory|\\officeservertransactions\\siteNames.csv",
Microsoft.VisualStudio.TestTools.WebTesting.DataBindingAccessMethod.Random,
Microsoft.VisualStudio.TestTools.WebTesting.DataBindingSelectColumns.SelectO

nlyBoundColumns, "siteNames#csv") ]

[DataBinding ("Sites", "siteNames#csv", "siteName",

"Sites.siteNames#csv.siteName") ]

8.

At the "WebTestRequest request1" line, add:

+ this.Context["Sites.siteNames#csv.siteName"].ToString() +

Installing and configuring lometer on the lometer VMs

1.

O N o vk WwN

Download the lometer 1.1.0 package for Windows from www.iometer.org/doc/downloads.html.

Double-click the installer, and click Run.

At the Welcome window, click Next.

At the License Agreement window, click | Agree.

At the Choose Components window, leave the defaults selected, and click Next.

At the Choose Install Location window, change the Destination Folder to C:\lometer 1.1.0, and click Install.
When the installation completes, click Finish.

Create the appropriate access specification file on the VM.

Setting up the lometer file server workload

1.

We used the following settings for each test:

Open lometer.exe.
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2. Create the appropriate access specifications. For each access specification:

a. Create the access specification to match the configuration in Figure 5.

b. Under Topology, select the computer name, and click the Start a New Disk Worker on Selected Manager
button until you have one worker assigned to the target volume.
Under Disk Targets, set the # of Outstanding I/Os to the appropriate number.

d. Setthe Maximum disk size to 100GB, using sectors as the unit of measurement. Sectors can be obtained
by dividing 100GB in bytes by 512.

e. Under Results Display, make sure that lometer has selected Start of Test.

f. Under Test Setup, set the Run Time to 45 minutes and the Ramp Up Time to 60 seconds.

g. Save the configuration.

3. Exit lometer.

Running the test
To run the test, we staggered the workload, allowing each benchmark time to warm up prior to measuring the
performance and latency on each of the solutions.
1. Begin running the LoadGen benchmark. LoadGen is set to run for 1 hour, with a 15-minute allotted warm-up
period and 45-minute test run time (recorded latency period).
2. Immediately after beginning the LoadGen benchmark, start the WSSDW workload. This workload is set to run for
1 hour, with a 15-minute warm up period and a 45-minute run period.
3. Five minutes after LoadGen and WSSDW begin, start the DVD Store benchmark. DVD Store is set to warm up for
10 minutes, and then run for 45 minutes of recorded performance to coincide with LoadGen.

4. After 10 minutes, begin the lometer file server workload and run it for 45 minutes.
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APPENDIX D — TEST RESULTS

Figure 7 shows the median run test results of our 200-user workload comparing the Dell PowerEdge T630 with

the legacy server.

HP ProLiant ML350 G6 | Dell PowerEdge T630 Percentage win
Exchange Server / LoadGen 81.04 167 97.94
latency (ms) — 200 users
SharePoint Server / WSSDW 0.22 0.16 27 97
latency (sec) — 200 users
File server / lometer
(IOPS) — 200 users 53.29 123.60 131.94
(Sélll_ljlc)arver database / DVD Store 3,068 16,014 421.97

Figure 7: Detailed results for the legacy server and the Dell PowerEdge T630 with 200-user workloads.

Figure 8 shows the median runs for the memory and SSD upgrade steps. For each step and user count we tested,
we used the following pass/fail requirements:
e Exchange latency needed to remain under 100ms
e SharePoint latency needed to remain under 1s
e File server IOPS needed to be at a minimum of 0.3 IOPS per user (60 IOPS for 200 users, 90 IOPS for 300, and
120 I0PS for 400)
e Each SQL database instance had to be above 14,000 OPM

Base configuration: Memc{ry upgrade SSD.upgra.de
128GB memor configuration: configuration:
18 x 1TB SAS/SAYI"A 384GB memory, 384GB memory,
HDDs 18 x 1TB SAS/SATA 14 x 1TB SAS/SATA
HDDs HDDs + 4x 800GB SSDs

Exch L

xchange Server / LoadGen 1.67 (200 users) 2.03 (300 users) 1.69 (400 users)
latency (ms)
sharePoint Server / WSSDW 0.16 (200 users) 0.14 (300 users) 0.51 (400 users)
latency (sec)
(FI'SP;‘;W”/ lometer 123.60 (200 users) 216.08 (300 users) 307.27 (400 users)
SQL Server database / DVD Store 16,014 14,634 15,384
(OPM)
SQL Server database / DVD Store
(OPM) — Instance 2 14,582 15,562
SQL Server database / DVD Store
(OPM) — Instance 3 15,532
SQL Server database / DVD Store
(OPM) — Instance 4 15,496
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SQL Server database / DVD Store
(OPM) — Instance 5

SQL Server database / DVD Store
(OPM) — Instance 6

SQL Server database / DVD Store
(OPM) — Instance 7

SQL Server database / DVD Store
(OPM) — Instance 8

SQL Server database / DVD Store
(OPM) — Instance 9

SQL Server database / DVD Store
(OPM) — Instance 10

SQL Server database / DVD Store
(OPM) — Instance 11

SQL Server database / DVD Store
(OPM) — Instance 12

Total OPM

15,458

15,424

15,366

15,492

15,446

15,513

15,529

15,443

185,645

Figure 8: Detailed results for the Dell PowerEdge T630 baseline configuration, upgraded memory configuration, and

upgraded SSD configuration.
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